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Disclaimer 
The use of GPS devices, tablets and smartphones with MapItFast and associated AgTerra products 

 
The internal GPS in your device can be used independently from online services to 

automatically set location information in the app, which is recorded as latitude and 

longitude. 
 

GPS accuracy may be influenced by topology, environment and equipment.  
Furthermore, the accuracy of the maps used in MapItFast (and its associated products: 

Strider, SprayLogger and TrackItFast) are not guaranteed.  Please use care when using 
MapItFast. 

 
MapItFast requires online data transfers for some features, such as accessing 

online maps and sharing exported files. Accessing these features over data 
network services may incur costs from your provider. If you use the app and data 

services on your tablet, you are responsible for any fees that your service provider 
charges. Your service provider is not the provider of MapItFast. 

 
AgTerra Technologies makes no representations, expressed or implied, as to data 

accuracy, completeness, validity or suitability. The end user assumes the entire risk as 

to the quality of the data.  AgTerra shall not be liable regardless of the cause or 
duration, for any errors, inaccuracies, omissions, or other defects in, or untimeliness or 

unauthenticity of data; or for any delay or interruption in the transmission of data to 
the user; or for any losses, injuries or damages arising from its display or use.  
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Welcome to the help guide for MapItFast online.  MapItFast is designed to be the easiest way to gather 

and map point, line, polygon and camera images to create maps that may be easily shared with others. 

MapItFast is comprised of a field data collection component (Android smartphone or tablet) and a cloud 

services component for map management, sharing, and storage.  With MapItFast, you have the ability to 

allow teams to collaborate on the same project in near real time.  Maps may be shared with others 

and/or exported to formats accepted in third party GIS software such as Google Earth and ArcGIS. 

This help guide is designed to walk you through the operation of MapItFast on the MapItFast Website.  

Please feel free to contact us at mapitfast@agterra.com  or call us directly at 1-866-408-2675 if you need 

additional help or would like to receive assistance via a live web meeting. 

 

Login 

Go to http://www.agterra.com/login/ and click the MapItFast login button at the bottom left of the 

screen. You can also use this window to navigate to the login pages for Strider and SprayLogger. 

 
After clicking the login button, you will be directed to the MapItFast login page.  

Introduction 

mailto:mapitfast@agterra.com
http://www.agterra.com/login/
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Reset Your Password 

If you forget your password and have to log in using a temporary password, you can change it by 

going to Users  and clicking Change Password. You will be asked to enter your current 

password, provide a new password, then enter it again to confirm your changes. 

Don’t forget to check the box 
agreeing to the terms and 
conditions of the MapItFast license! 

Forgot your username or password? 
Click this link to have a temporary 
password sent to the email address 
associated with your account. 
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Update Account Information 

You can update information about your account by going to Users  and clicking Personal 

Information. 

 

  

 

 

 

 

 

 

 

Note 
Some menu options and activities are only available to administrators.  This guide covers 
administrative as well as more limited user options.  If you see an option in this help guide 
that is not available in your account, check with your administrator. 

 

The name and email associated with 
an account can be edited here. 

 

Need metric units? 

Select True from the dropdown list to 
change map units to metric. 
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MapItFast opens with a map viewer and Google Terrain basemap.  The map will be centered on the 

address associated with your account. 

Map Navigation & Basemaps 
Zoom functions are available in the upper left hand corner of the map viewer. Users may also 
zoom in and out using the scroll button on their mouse and pan by clicking and holding the left 
mouse button. 
 
Users can choose from five different basemaps- Bing Aerial, Google Terrain 
(default), OpenStreetMap (OSM), Google Aerial, and Google Hybrid. 

 
 
 

 

 

 

Map Viewer 

The basemap button is located on 

the right-hand side of the map 

viewer just below the search and 

select tools. 

 

The number between the zoom in and 

zoom out buttons refers to the map “zoom 

level.” These numbers directly correspond 

to the same zoom levels on the app. 
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The Project Menu 

MapItFast data is collected and managed through Projects. Projects are synchronized with mobile 

devices and can be shared with authorized users.  The Project Menu allows users to create a new 

project or load, share, rename or delete an existing project.   

 

Projects may be shared with single users or groups of users set up in the organization’s account.  If a 

project is actively in use in the field, the online map will be update periodically with a user’s last 

known positions in as little as 5 seconds.   Team members must be working in the same project with 

an active data connection for their current position to display and they must have their device 

settings set to synchronize. 

 

A folder system helps to manage multiple projects.  Projects created on a device can be placed in 

folders online after they have been synced.  Unassigned projects (such as those created on a device) 

automatically go in the ‘Uncategorized Projects’ folder. The last update time and user name are 

displayed next to each project.  The folder name, or any changes to the folder, do not display to the 

Android user; he/she will only see the Project name. 

 

 

See more details about each 
project by changing the View 

Mode from Folders to Details. 

Right-click on a project to edit the name 
(Edit), change project permissions (Share), 
or remove a project and its data (Delete).  
Some users may not have permission to 
make changes to projects. 

Folders can be created to 

keep projects organized. 

The last update time and user name 

are displayed next to each project. 

Create new projects here.  

Some users may not have 
permission to create new projects. 
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After the chosen project has loaded, features (data items including points, lines, polygons and camera 

images) will be displayed. 

 

Objects in a map are created using either MapItFast mobile or by adding new features (or editing existing 

features) on the Internet map viewer.  Clicking on a point or camera icon, line or polygon object will bring 

up all data associated with that object.  An example showing a picture item is shown below: 

 

 

 

The green bars in the lower left corner 

of the screen show the status of your 

project. It may take a moment or two 
for all objects to load in larger projects.  

Click on the tabs above to 
see the object description 

and view any attached forms. 
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The MapItFast online viewer allows users to add new points, lines and polygons to a new or an existing 

map.  To add a new point, line or polygon, click on the button (located on the left hand side of the map 

viewer) for the feature type you would like to create. 

 

 
If you draw a line, MapItFast will calculate the total length (in feet) and display it in the object Info 
window. If you draw a polygon, the area (in acres) will be displayed in the Info window. 

 
Edit/Delete Features 

There are two ways to edit or delete a feature in MapItFast: 

 

Point 

Line 
 

Polygon 
 

Click the Point button to add a point object to the map. Your cursor will become a blue 
teardrop shape with instructions to add a point. 

Click the Line button to add a line. Your cursor will become a blue teardrop and you can 
begin drawing your line, clicking at each vertex. You can also create a continuous line by 
clicking and holding the mouse button. Click the last point again to end your line. 

Click the Polygon button to add a polygon object. Your cursor will become a hand and 
you can begin drawing your polygon. You can click once at each vertex or click and hold 
to draw a continuous line. Click the first point of the polygon to finish the drawing. 

Add Data 

Right-click 
Right clicking on a feature will bring up a 
menu with options for Editing, Deleting, 
Copying, and Moving an object. 

Left-click 
Left clicking on a feature will open the 
Object Info window which will have buttons 
for Editing and Deleting an object. 
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Edit a Point 
 

The point name can be changed here. This is 
the primary text that appears when you 
hover over an object in the map.  

Give the point a description here. You 
can be as descriptive as you need and 
use text formatting to emphasize words 
or create a list of notes. 

Change the point symbol here. Points 
may be uploaded and then sorted into 
folders in the Icon Admin page. 

Give the line description. This text will 
appear beneath the Object Name when 
you hover over it in the map. 

The line name can be changed here. 

Choose a solid or dashed line. 

Change color and transparency of 
the line with the color picker. 

Change the line width here. 

Edit a Line 
 

The original creator of the object is shown in the 
dropdown list. Name can be changed if necessary. 

You can also adjust the vertices on lines and 
polygons when the Editing window is open. 
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Be sure to select the “Save” or “Cancel” buttons to complete editing.  Distance or area will be 

automatically recalculated and all edited and updated data is synchronized with other users. 

 

Edit Vertices 

Edit a Polygon 
 

The polygon name can be changed here. 

You can also adjust the vertices 
on lines and polygons when the 
Editing window is open. 

Give the polygon a description. 
This text will appear beneath the 
Object Name when you hover 
over it in the map. 

Use the color picker to change the color 
and transparency of the polygon fill and 
outline. 

Remember to click Save to 
finalize your changes! 

Using the Color Picker 

Final color is shown here 

2) Select a lighter or darker 

shade of a color by moving the 
second circle in the triangle. 

3) Set the object’s 

transparency with the vertical 
bar on the right. 

1) Choose your base color by 

moving this circle around the 
ring. 

This box shows the color code. 
This code can be changed if 
you know the code of your new 
color. 
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Polygons and line objects may be edited by adding, removing and/or adjusting the location of vertices. 

When in Edit mode, the vertices will appear as small gray and white squares along the object. You can 

change the shape of a feature with the following actions: 

 

 

Copy/Move/Delete Features 

Point, line, polygon and photo features on a map may be copied and/or 

moved to another project.  Copying and moving features is a good way to 

keep projects organized and to combine mapped features from multiple 

projects and multiple users. 

 Move This to Project: Removes the object from the current project 

and pastes it into the selected project. 

 Copy This to Project: Leaves the object in the current project and 

creates a duplicate of the object in the selected project. 

 Copy This to Layerset: Leaves the object in the current project and creates a duplicate object in the 

selected Layerset. 

Single Features 

An object can be copied, moved, or deleted by simply right-clicking on the object and selecting the 

appropriate action. This may be useful if only one object needs to be moved. If you need to copy/move 

multiple options at a time, you will want to use the method described below. 

Multiple Features 

Follow the steps below to copy or move multiple features from one project to another: 

1) Click on the Select button located in the upper left portion of the 

Internet map viewer. 

2) Click and hold the left mouse button and drag a box 

around the features that are to be copied or moved.  Selected 

items will become “highlighted’ by turning purple. 

3) Use a right mouse click in the map viewer (in an area where items 

have not been selected) and the menu below will display: 

Left-click on a white 

vertex to delete it. 

Left-click on a gray vertex 

to add a new vertex on 
either side of the point. 

Click and drag any vertex 

to adjust the shape of your 
line or polygon. 
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4) Choose whether to move or copy all feature objects to another project.  An action box (shown 

above) will display allowing the user to move or copy the objects to a new or existing project. 

 
 
 

 

 

 

The menu bar is located at the top of the map and provides users with tools to export data, print 

maps, add layers, import GIS data, manage users and change general map related settings.  The active 

project name is also displayed for reference. 

 

 

Export Data 
 

MapItFast projects and data may be shared with others or exported for use in third party GIS software 

systems such as Google Earth, ArcGIS, Delorme, All Topo, MapSource and others.  One or all of the file 

formats (SHP, KMZ and GPX) are generally accepted in other GIS software applications. 

Hint:  If you would like to add one or more features to a selection, or remove any from a selection, hold  the 

“CTRL” key on the keyboard while selecting features you wish to add or remove. 

Top Menu 

Export to 

KMZ for Google Earth 

Shapefile for ArcGIS 

GPX for GPS Units 

MPF for MapItFast 
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Use the steps below to export one or many projects: 

 

 

 

 

 

 

Layersets 

Layersets can be used as a reference to existing basemaps on the MapItFast app and/or the 

MapItFast Internet map viewer. They provide a faster, more efficient way to view large sets of 

data such as parcels or mileposts.  

 

 

 

 

 

Hint:  a large project may take some time to process, so if your export file does not show 
up immediately in the Export box (Step 5), wait for it! It may take a minute or two. 

Select the project(s) to be 

exported 
 

1 

Select which features to include in 

the export (points, lines, polygons, 

pictures). 

2 

Select the file format for export.  
(Note:  GPX format can only 
export points and lines).  

3 

Give the export file a friendly file name and 

select Export.  A message showing 

processing status will display.  Once 

completed, the available download will be 

shown in section 5. 

4 

A list of available downloads will be 

displayed.  Select the available download to 

download the file.  Projects on this list 

remain active for 2 days before they are 

deleted from the server. 

5 
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Activate Layersets 
Users can turn layersets on or off by going to Layersets > Activate Layerset. A menu will open on the left side 

of the screen with all available layersets. Chose one or more layersets to 

display and then click the Update button. The layersets will begin to load on 

your map. 

 
 

 

 
 

 

 

Manage Layersets (Administrators Only) 

 

The Layers management page allows administrators to create new layersets and 

upload shapefiles to new or existing layers. Administrators can access the layerset 

management page by going to Layerset > Manage Layerset. 

The following applies to MapItFast layerset management: 

1) Imported data must be in Geographic Coordinate System (GCS) WGS-1984 projection or UTM 

projection. 

2) Layer import is limited to 100,000 objects per layer and 500,000 objects for all layers in an 

account.  An object is a single point, single line, or single polygon in a GPX or shapefile.  For layer 

import of larger files, please contact AgTerra. 

3) Layers are imported as ZIP files.  Zipped shapefiles include the files with SHP, SHX and DBF 

extensions.  The PRJ extension is optional if uploading in GCS WGS84, but required for UTM 

projection.  For GPX files, simply zip the GPX file to prepare for import.  Zip files must be under 5 

MB in size.  Contact AgTerra for assistance with larger files. 

4) Different layer types can be stacked into one layerset.  That is, point, line and polygon layers can 

be combined to create a single layerset overlay that is served to all users (online and mobile) on 

any project.   

5) Symbology may be applied to imported shapefile attributes making it possible to color code lines 

and areas based on information contained in the DBF file used with shapefiles.  Furthermore, 

features may be labeled based upon the same attribute or another attribute and made to display 

only at certain zoom levels. 

6) Transparency may be applied to the symbology.  This is encouraged since the layersets may be 

viewed on different basemaps on the Internet and mobile based maps and it may be desirable to 

view the basemaps as well.   

http://www.agterra.com/company/contact.html
http://www.agterra.com/company/contact.html
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The DBF file used for import should only contain the data fields you intend to use for symbology and 

labeling.  Extra data fields can greatly increase file size and decrease performance when visualizing the 

layerset. 

Create a Layerset 
 

Click on the Layers button to bring up the layerset menu displayed here.  Then click on ‘Manage Layersets.’  

To create a new layerset, select ‘Create Layerset.’  

 

You can give your new layerset a name and description in the Layerset Information window. You can 

also choose to keep the layerset public or only allow certain users to view it. 

 

You will see the newly created Layerset in the MapItFast Layersets screen.  To add shapefile data, 

click Upload Data on the right. 

 

 

Select ‘Choose File’ to choose the ZIP file containing the shapefile you wish to upload.  When you 

have selected the appropriate file, you can give it a Layer Name.  Then click ‘Upload.’ 

 

Changing the Access choice to Private will 
open a list of available users with 
checkboxes next to each. You can check 
the boxes next to any groups or 
individual users who have permission to 
view the layerset. 
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The next window will tell you the shapefile type, geometry 

type, and number of objects in the file. You will be asked to 

choose which attributes you would like to bring into the 

layerset. Note – Choose five or less attributes to help 

improve the processing time. Once you have selected the 

desired attributes, click Continue Processing. 

 

Your file may take several minutes to process. 

 

Click the red link to see the 
shapefile requirements for 
layersets. 

This layer is made up of points, so the 
available options are color shape, and 
size of the points. If the layer included 
any lines, you would also be able to 
choose the line color and width. 
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When the shapefile is done processing, the Layer Display Settings page will open. Here, you can 

adjust the appearance of the objects and labels of the layer. When you are done, click Save Changes 

and wait for the changes to process. This can take several minutes. 

Once the changes have been processed, you can preview your display settings by going back to your 
map viewer and activating the layerset. 

 
 

 

Tools 
The Tools menu provides user with useful utilities including the ability to navigate to X, Y 

location, import data, and print maps.   

 

Go to X, Y 
Go to X, Y allows users to enter 

coordinates either in Degrees, Minutes, 

Seconds format or Decimal Degrees 

format.  After entering coordinates a 

point will be placed on the map showing 

the location.  By using a left mouse click 

on the point, users may convert the point to a feature point on 

the map or clear the point.  If the location is converted to a map 

point, it will become part of the project and synchronized with 

other users. 

Hint:  in the United States, users need to enter longitude values as 

negative numbers by including a minus sign in front of the number. 

Hint:  if a large number of labels will be displayed, set the zoom level so that labels are only displayed after zooming in to an 

appropriate level.  This will help speed the display of labels on the map being rendered and assure that it is not too cluttered to 

read. 
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Import Data 
 

 

Shapefiles can be imported to MapItFast as modifiable, searchable objects using 

the Import Data feature. It is important to know the size of your shapefile because a large file can 

cause MapItFast to load a project very slowly. Follow the steps below to import a shapefile: 

1) Make sure that your shapefile is in GCS_WGS_1984 - Decimal Degrees. A UTM projection allowed 

if the .prj file is included. 

2) Create a zip file that includes file extensions .shp, .shx, .dbf, and .prj (must include all extensions 

or the shapefile will not import) 

3) Go to Tools > Import Data. 

4) Click the green + Add Files button and browse to your zip file. 

5) Once you select the zip file, MapItFast will immediately begin to import the file. Click the Close 

button to see your objects in the map. 

 

If you have a shapefile with data that will be used primarily as a reference layer, you can upload it as 

a layerset instead. Layersets can be turned on or off and will display data as an overlay on your 

basemap. Unlike MapItFast objects, you cannot modify layerset data. This is often a good option for 

large datasets such as county parcels or mile markers because layersets can handle large files more 

easily. See more about layersets here. 

 

 

MapItFast provides users with the ability to import GPX files from Garmin units or 

other sources.  This tool is particularly useful for displaying waypoints and track logs collected using 

Garmin units.  GPX data is added as feature points and lines to the active project in MapItFast and 

may be exported and shared like all other feature data.  The import data feature provides a 

convenient way to share 3rd party data with others and a method to translate the data to KMZ or SHP 

format for use in other GIS software. 

Import a single GPX file by browsing for it or add multiple GPX files by first zipping them up and then 

browsing to and uploading the zip file. 

 

Shapefiles 

GPX Files 

→ All attributes from a shapefile will be displayed in the object’s Description when the file is 

imported to MapItFast. If you want to name the objects according to a certain attribute, you will 

need to use ArcGIS or other third-party program to create a column called “TITLE” in the attribute 

table. MapItFast will use the values in the TITLE column to name the imported objects. 

→ Also note, the name of an object cannot exceed 63 characters. Check that all names in the TITLE 

column do not exceed this number or the MapItFast import will not work. 
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Project data can also be exported and imported as an MPF file, which is a 

proprietary MapItFast format.  This export provides an easy way to transfer project data from one 

project to another when projects are in different accounts.  MPF exports contain points, lines, 

polygons and pictures.  As of this writing, form data (collected through a Strider Forms and Reports 

add-on) and custom icons are not exported.  MPF files do not have to be ‘zipped’ or unzipped. 

 

 

 

Image files such as photos taken with a digital camera or even graphics like 

company logos can also be added to MapItFast.  The Import Picture tool allows users to browse for 

the picture they would like to upload into their map.  If the photo already contains GPS data for a GPS 

ready camera, it will be placed correctly in the map.  If neither option is available, MapItFast notifies 

the user that there is no GPS data and the image is placed in the center of the current map view. 

Imported pictures become part of the project and are synchronized with other users on the project. 

 

Print Page 
The ‘Print Page’ tool allows users to print the current view to their local printer.  Select ‘Print Page’ and 

choose the printer and desired settings. 

 

 

MPF Files 

Image Files 

Images without GPS data will be placed in 
the center of the map. To move the 
photo, left click the point and click the 
Move button beneath the point details. 
You can then drag the point to any 
location on the map. 
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To print maps with additional cartography options, you can either export the map as a KMZ file and open 

in Google Earth or export as a shapefile and create a map in ArcGIS or other GIS program. 

 

Google Earth’s print option is quick and easy-to-use option for printing maps with common elements 

such as a legend, north arrow and scale bar. Follow these steps to create and print a map with Google 

Earth: 

1. Export the desired job to a KMZ file and open it in Google Earth or Google Earth Pro. 

 

2. Pan and zoom as needed to center the map exactly how you want it to look in your printed map. 

 

3. Go to File → Print… 

 

4. The print layout will open. By default, the map will have a title and description box, legend, north 

arrow and scale bar. 

 

 

If the default “Portrait” orientation doesn’t look 
quite right, try changing the setting to “Landscape.” 

The page can be scaled down to include 
more of the map on the page. 
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5. To add or remove map elements, click on the Map Options button in the toolbar. 

Printed maps can have 

the following elements: 

 Title & Description 

 Legend 

 Scale bar 

 Compass 

The elements can also be 

scaled down to a smaller 

size by adjusting the 

Scaling percentage. 

The title and description 

can be edited as needed 

Click on the legend to add or 

remove items from the list (will not 

affect what is shown on the map) 
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6. The final map can be printed or saved to a PDF. 

Users 
The ‘User’ button allows MapItFast users to manage their personal login information.  When 
users click the button, they will only see the option to change their personal information, change 
their password, or to log out of MapItFast. Administrators also have the ability to create new 

users and groups of users and control their interactions with other users, groups and projects. New 
users may be assigned administrative privileges for open access to projects and full control within the 
organization’s MapItFast account including other administrative functions such as layerset 
management, data dictionary management, and the ability to create additional users; or general user 
privileges which restrict access to projects (unless shared by others or created by the user). 

Manage Users (Administrators Only) 

Administrators have the ability to set up Users and 
Groups through the Users button. 
Administrators are able to create new users, edit users, 
and assign a role to users (administrator rights or user 
rights).  An email address is collected so that password 
credentials may be emailed in the event that a user 
forgets or loses them.  Be sure to ‘Save Changes’ 
before exiting the window. 

Hint:  Log in credentials are 
the same for MapItFast 
accounts both on the Internet 
browser and through the 
mobile app.  The same 
credentials will also work with 
Strider. 
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Manage Groups (Administrators Only) 

Administrators can set up and manage groups through the Manage Groups page. This makes it easier to 

share a project with multiple users that may require access to the same project. 

Hint:  Usernames cannot be edited or deleted, only inactivated.  If temporary users come 
and go, consider generic usernames such as employee1, internA, fieldtech_3, etc. so that 
usernames can be ‘recycled’.  Note, user names can be shared among devices but only one 
can be used (logged in) at any one time.  

Scroll to the right to see more information and to 
Disable a user if they are no longer using an account. 
You can also re-enable a user who has been disabled. 

Click edit to change a user’s role (User or 
Administrator), change the user’s assigned group, and 
change the associated name and/or email address. 

Any disabled users will be 
hidden unless you check this box 

Click Change to view which projects this user has 
permission to view/change and make adjustments as 
necessary. 

Manage Users 
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Default Permissions (Administrators Only) 

Administrators can set up permissions that will be applied each time a new project is created. Permissions 

can be set so that they apply to any new project created, or administrators can create even more specific 

permissions that apply to certain users who create projects. This might be helpful if you only want certain 

people to be have the ability to contribute or edit a project when it is first created.  

 

  

 

 

 

Manage Groups 
 

Add New will let an administrator change the settings so that a new 
project created by a specified user (or user within a group) will have 
certain default permissions. 

Default Permissions will 
apply to all new projects 
but can be overridden by 
individual user defaults. 
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License Summary (Administrators Only) 

Administrators can view current and past bills in the License Summary window. A summary can be exported 

to Excel, Word, or to PDF by clicking the icon with the purple disk and green arrow. 

 

Settings 

The settings function enables users and administrators to manage the look and feel as well as 

content of the site.  This includes icons and colors used by default to represent map features 

and whether or not these features should be displayed on the online map.  Data Dictionaries 

allow the administrator to set up pre-populated lists of items that are displayed as selectable options 

to help standardize attribute names assigned by mobile users while mapping points, lines, polygons 

and photos. 

Icon Admin 
The icon administration page allows you to view all available map icons and add new icons for use in 

MapItFast.  If you would like additional icons, you can upload your own or request additional ones from 

AgTerra. 

 

 

 

 

 

 

 

Right-click on a folder to rename or delete it. 

Right-click on an icon to delete it. 

Icons can be sorted into folders by drag-and-drop 
method. To start a new folder, drag an icon to ‘New 
Folder.’ 

Upload new icons here. Recommended file format is 
PNG and recommended image size is 50 by 50 pixels. 
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Map Colors 

The Map Colors page will allow you to establish the default colors and 

sizes for lines and polygons. These will be the default colors for GPS 

track lines, mapped lines and mapped polygons.  A color is selected via 

the pull-down color picker. The transparency of the color may also be 

adjusted using the opacity control.  The line width is used in the GPS 

tracks, mapped lines and mapped polygons as well. 

These colors will also export for use in Google Earth as a KML file. It is 

important to note that these default colors will not apply to data exported into SHP or GPX formats 

and the preferred colors are not applied to mobile devices.  To change colors for individual features 

on the mobile device, select ‘Map Colors and Display’ under the ‘Settings’ menu on the device. 

Data Dictionaries (Administrators Only) 

Data Dictionaries allow an organization to standardize names used while collecting data on the 

mobile device.  This is particularly useful in assuring all remote users use the exact same feature 

name for a particular item mapped in the field.  This makes it easy to manage large datasets in 

MapItFast and in third party programs where the data may be exported.  Data Dictionaries and items 

in a data dictionary may only be managed by the administrator of the organization’s MapItFast 

account.  Data Dictionaries and their items may not be modified or deleted on mobile devices. 

The Data Dictionary page will display all current dictionaries in your MapItFast account. From here, 

you can create a new dictionary or modify existing ones. Click on Edit next to an existing dictionary to 

see more options. 
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Click the Add Item button to add a new item to your Data Dictionary list. Each new item can be given 

a name and assigned to one or multiple geometry types. The item will only appear in lists that are 

associated with that geometry type. For example, it the user is placing a Point, ‘Oak Spread’ and 

‘Canada thistle’ would appear in the Weeds data dictionary. ‘Area of Weeds’ would only be selectable 

if the user was generating a polygon. 

The icon used for a particular item may be changed by clicking on it.  Polygon and line color can be 

chosen using the color picker or by typing in the color code if known. See how to use the color picker 

here. 

Administrators may want to set the list to display most frequently used items at the top.  Mobile 

device users will see the list order change based on how frequently they select that item when 

mapping.  However, to assure that some items in the list always remain near the top, you can click 

the ‘Move’ symbol in the Drag/Move column and adjust the items up or down to place more 

commonly used items at the top of the list. Note that symbols selected for items in this section only 

display on the online map viewer and with data export to KMZ format. 

Remember to click Save after 
you have made changes! 
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Viewable Content 
It is sometimes helpful to view only certain objects within a 

project. The Viewable Content window allows you choose 

which types of objects you want to show or hide when 

looking at your map. Changing the viewable content will not 

change the settings for any other users on your account; 

this setting is just localized to your web browser. 

 

 

 

 

The tools on the right-hand side of the map viewer allow users to search, select, and modify one or more 

objects in a project. 

Search  
Search for keywords associated with points, lines and polygons with the search tool. The tool will look in the 

title, description and any attached forms (if selected). The calendar widget may also be used to filter the 

search according to a defined time frame.  

 

 

 

 

Side Menu 

Check this box to also search 
any attached Strider forms. 

The calendar widget can be used to 
search for objects added within a set of 
defined dates. 
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Once the search is complete, a new dialog box will display the results in a popup menu. 

 

Lasso Select  
 

The Lasso Select tool allows users to draw a freehand “loop” around objects to make a selection. To select 

objects with the lasso tool, hold down the left mouse button while drawing around the desired objects. 

When the mouse button is released, MapItFast will finish the drawing and open the Selected Objects popup 

window. 

 

 

MapItFast will finish the 
lasso drawing when the 
mouse button is released. 

All object types will be selected. 
These can be filtered in the 
Selected Objects window. 

If a line extends beyond 
the selected area, the 
entire line will be selected. 
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Box Select  
 

The box select tool works much like the lasso tool. To select objects, hold down on the left mouse button, 

draw a box around the desired objects, and release the button to finish drawing. The Selected Objects popup 

window will appear. 

 

 

 

Selected Objects 
The "Selected Objects" window will open after objects have been selected using the Search, Lasso, or Box 

Select tool. This window contains many useful tools for modifying map data. Tools include: 

Filter selected objects by type 
The drop-down list in the Selected Objects header enables quick filtering of selected objects by type. 

 

The Type filter list will only show the object 
types present in the current selection. 

MapItFast will finish the 
box drawing when the 
mouse button is released. 

All object types will be selected. 
These can be filtered in the 
Selected Objects window. 
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Refine selection with keyword(s) 
Type keywords into the “Refine” text box to narrow the results. MapItFast will search both the object 

name and object description for keywords. 

 

Copy objects to another project 
The copy tool can be useful for copying objects to or from a “master” project. If Strider forms are 

attached to objects, any updates made to the forms will be reflected in both projects. 

 

Move objects to another project 
If an object was inadvertently added to the wrong project or a set of objects need to be moved to a 

different project for any reason, the Move tool can be used. 

 

 

 

 

 

 

The list of objects will filter as you type. 

The Copy tool can be used to copy objects to a new 
or existing project or to a new or existing layerset. 
 
Note – any forms attached to objects will be copied 
to the new project as well. If a form is edited in the 
new project, the edits will appear in the original 
project as well. 

The Move tool can be used to move objects 
to a new or existing project. 
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Rename selected objects 
Quickly give a set of objects the same name with the Rename tool.  

 

Edit selected object appearance 
The Edit tool is useful for a variety of applications. For example, objects imported from a 

shapefile may need to be changed from the default appearance settings. These objects can be 

easily edited with the selection features and Edit tool. 

 

Buffer selected objects 
Buffers can be used to determine proximity to items on the map or get calculate area based on 

a line or point on the map. 

 

Attach forms to selected objects 
Objects can be associated with a certain form through the Forms tool. When users need to fill out a 

specific form for some or all of the objects in a project, this tool can help by attaching a record to 

each object which can later be completed in the field. 

 

The Rename tool can be used to change the 
name of all selected objects. 

The Edit tool can be used to modify selected 
objects. Point icons, line width and color, 
and polygon fill and outline can all be 
adjusted with this tool. 

The Buffer tool can be used to create a 
polygon buffer around each of the selected 
objects. Buffer distance can be entered in 
feet or meters. 

The Forms tool allows you to attach a filled 
form to each of the selected objects. “New 
Form” will open the list of all available 
Strider forms and “Existing Form” will open 
a list of forms already attached as well as 
the individual records for each form. 
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Delete selected objects 
Deleting objects will take them completely out of the system. Only delete objects if you are sure you 

won’t need them again. 

 

Project Permissions 
 

Projects that are created by or available to a user may be shared with others who have access to the 

organization’s MapItFast account. Right click a project name in the Project Menu to open the permissions 

settings window. 

 

 

Groups or individual users can be given permission to View, Contribute, Edit, and/or Delete objects 

within a project. Note - Users and groups can only be created by an administrator. More about setting 

user, group and project permissions can be found in AgTerra’s Permissions Guide. 

 

Project Menu 

The Delete tool can be used to delete all 
selected objects from the project. 
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Terminology (Group): 

View- Members have ability to only view the points, lines, polygons and pictures within project. 
Contribute-Members have ability to add new points, lines, polygons and pictures to project. 
Edit- Members have ability to change the shape, location and/or edit the attributes of each object 
within project. 
Delete- Members have ability to delete objects within project. 
All- Group members are assigned permissions to all objects within a project, regardless of who 
contributed it. 
 
 

Terminology (Individual): 

View- User has ability to only view the points, lines, polygons and pictures within a project. 
Contribute- User has ability to add new points, lines, polygons and pictures to a project. 
Edit- User has ability to change the shape, location and/or edit the attributes of each object within a 
project. 
Delete- User has ability to delete objects within a project. 
All- The user has the assigned permissions to all objects within the project, regardless of who 
contributed it. 
Default- The user has the same permissions as the group the person is in. 

 

 

 

 

  

Hint: Permissions set for an individual will override group settings. Therefore, even if a 
group only has permission to View a project, a user within that group can have 
permission to Edit if their settings are changed to in the User section. 
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MapItFast displays spatial data for two additional products available through AgTerra –SprayLogger 

and TrackItFast. If you have either product set up as an add-on to MapItFast, you will see a button in 

bottom right hand corner of the map viewer. 

 

 

 

  

Add-on Features 
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SprayLogger Button 
Clicking on the SprayLogger button will open a sidebar on the right-had side of your screen. From here, users 

can load SprayLogger projects onto their map, export data, generate reports, and go to the SprayLogger 

website. 

 

TrackItFast Button 
 The TrackItFast button will open a new window at the bottom of the map viewer with the option to turn on 

tracks for different assets. You can also manage geofences, alerts and display options. 
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Submit a Help Request 
Besides this help guide, help may obtained by selecting ‘Submit a Help Request’ under the help menu. 

After entering a request and selecting ‘Submit Request’, you will receive a confirmation message and 

our staff will provide assistance as soon as possible. 

The Help button also provides a link to this Help Guide, and to AgTerra’s Privacy Policy. 

Technical help can also be obtained through email at solutions@agterra.com. 

Help 

mailto:solutions@agterra.com

